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This user guide was made using:
4.0 version of the Axicon Camera Verifier Software for Windows.
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Introduction

The Axicon 15000 series verifiers are designed to work with any PC running a
currently supported version of Windows (Windows 10 & 11 - both 32 bit and 64 bit
versions).

Specification and application

The 15200’s field of view is 60mm x 45mm, and is designed to verify linear and 2D
barcodes, including those used on retail point of sale and healthcare items. These
are typically EAN/UPC or GS1 DataMatrix symbols.

The 15500’s field of view is 95mm x 70mm, and may be used to scan a larger range
of barcodes at different sizes. These include all GS1 symbols, and Code 93, Code
128, ITF, MSI Plessey - if they are no wider than 95mm.

The software is able to decode the following symbols:

Linear barcodes: EAN-8, EAN-13, UPC-A, UPC-E, Code 39, Code 93, Code 128,
GS1-128, Codabar, ITF, MSI Plessey, GS1 DataBar, Laetus Pharmacode.

2D barcodes: Data Matrix, GS1 DataMatrix, QR Code, GS1 QR Code, GS1 Composite
Code and PDF-417.

Application standards: Data content checking can be carried out on all the symbols
that have been verified. This includes check digits, and combinations of

GS1 application identifiers and their element strings especially for various
healthcare applications.

Multiple barcodes within the field of view will be found and can be verified to the
appropriate standards.
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What is in the case.

o Axicon 15000 Series verifier

» Software CD

» Wallet containing this user guide, calibration card and certificate of
conformance to ISO/IEC 15426-1, 15426-2

e Cleaning cloth

System requirements

e Currently supported Windows Operating System (either 32 or 64 bit)
o 100 MB disc space

e 512 MB RAM minimum

o USB 2.0 port or higher

Software installation

Insert the CD into an appropriate drive and the Install program should start
automatically. If it does not, run autorun.exe. When the software has been
successfully installed, leave the CD in the drive, so that the USB driver will be
installed when the verifier is connected to the computer. The software is called
Axicon Camera Verifier, and the latest version can always be downloaded from the
Axicon website, www.axicon.com. The software will check automatically if a later
version is available. It can be used on any PC or laptop to view the verification scan
files that have been saved even when the verifier is not connected.

Hardware installation
Connect the USB lead from the verifier to a USB2 or USB3 port on the computer.
Please install the software before connecting the 15000 series verifier.
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How the verifier works

The verifier must be connected to a PC or laptop that is running a currently
supported version of Windows using the USB connection, and used with the Axicon
Camera Verifier program.

The verifier has two buttons, which both do the same thing, and either one is
pressed to turn the verifier on. The image capture process will start and you can
see what the verifier sees on the main software window. When the barcodes you
want to verify are in the right place, press one of the buttons again to begin the
decoding and verification of the barcodes.

Ideally each barcode should be verified when it appears on the final filled item,
in its final configuration. If the packaging by itself is verified, and is completely
covered by the verifier, the verification process will be good.

If the verifier is placed on its side, or upside down, take care to minimise the effect
of ambient light. Ensure that any semi-translucent substrates are backed by a
uniform black surface to minimise the effect of light being transmitted through the
substrate.

There are two buttons so that you can easily use the one that is most convenient if
you have the verifier on its side or upside down. The keyboard shortcut Ctrl + G is
the equivalent to pressing the button.

The image that has been captured and decoded can be saved as a scan file (.png),
and this can be re-verified at any later time. The software allows the creation of
verification reports for each barcode that appears in the image, and the user simply
clicks on the relevant barcode for which a report is required.

More details about this process, saving scan files, and saving verification reports are
explained later on in this user guide.
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Calibration

When you use the verifier for the first time, it will tell you that it must be
calibrated. This will ensure that its reflectance measurements are correct.

Take the calibration card from the plastic wallet, and place on a flat surface. Place
the verifier over the EAN-13 barcode or the Data Matrix code so that it appears in
the verifier window.

Then choose calibrate from the reader menu. The verifier will ask you to confirm
positioning and that the Rmax and Rmin figures shown on the window match those
printed on the card. If they are different, alter the numbers via the calibration tab
in the settings menu and restart the calibration process. You will then need to press
start.

The verifier software will then check the image, calibrate, and recheck the image.
When this has been done a message ‘Calibration Successful’ will be shown. After
this message, another scan will be made so that you can check that the verification
results are correct. The Rmin and Rmax figures need to agree with those on the
calibration card.

The calibration card supplied with the verifier provides barcodes with known
maximum and minimum reflectance values. The calibration card is certified for a
minimum of one year (unless it has been physically damaged).

When it is not being used please keep the card flat in its plastic envelope, and away
from direct sunlight. If the card shows any sign of damage - for example, scratches
or any change in colour - please obtain a new card from us.
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Getting started

After calibration, the home window for the software will look this:

The window main areas are explained below.

& Avicon Camera Verifier
Fle View Reader Help

PioE=D ASOH

Print Report

Check for updtes.

General Reader Scan
5012345678900
EAN-13

Pass grade

. 4 11 Print Gain
=) 4Iulgl Calibration Card
B Right Quiet Zone 10 items: 10 Pass
Height 229 mm

Width 377 mm
Aperture 150 pm

EAN-13

89.7%

Reflectance Margin

1 Symbol Contrast
& Minimum Edge Contrast

z
||||||| g

+ GS1 Healthcare Retail  GS1 Retail

5012345678900
Notes| Errors | Wamings

sior inge: 249 um to 660 um
N/A  Bar Height | 229 mm | Height of bars should be at least 23.0 mm

Found codes: 1

The top section includes the file menu and the toolbar with its command icons.

The File menu includes options for saving and loading scans, creating and printing
reports. The View menu gives access to Settings (F5) and User data.

The Reader menu provides options for choosing which verifier is operational, reader
information, scanning, decoding, and calibrating the reader (the verifier).

The Help menu provides access to the Axicon website, a check for software
updates, and information about the software.
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The Command icons on the tool bar are as follows:

TI% Quit the application, or use Ctrl + Q

Load a saved barcode image, or use Ctrl + O

Save the current image and verification report, or use Ctrl + S

Print, or use Ctrl + P

Start collecting barcode images in the field of view, or press one of the two
buttons on the verifier, or use Ctrl + G. This will be orange when the verifier

is connected and grey when it is not. It will change into a pause icon when
scanning.

VI1E

Stop collecting images from the current reader.

Decode barcodes in the current image. This will change into a stop icon when
the barcodes are being decoded.

Stop searching for barcodes.

Edit the settings for the application, or use F5

Used to calibrate the hardware, or use F2.

OOl F

Display and edit user-defined

 data for this scan. e

Application Validation: N/A

General Reader Scan

http://www.axicon.com

If you move the cursor over the R Code 2005
encoded data in the general tab and
right click this will bring up the option
to copy the data to clipboard. If there
is a web address here you can also
click to open it in your default web
browser.

Copy to dipboard
Open URL: http://www.axicon.com

79 um, 9%
78 um, 9%
3

2

Q

500 um
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Getting started

The top right section provides the overall results for the verification. It will provide
the grade in the format n.n/aa/www (X), where n.n is the ISO/IEC grade, aa is the
aperture reference number, www the wavelength of the light being used for the
verification in nanometres and X is the ANSI equivalent.

This panel also has three tabs, where the first set of information about the barcode
is shown.

The General tab will show you the decoded data from the symbol, its x and y
dimensions, the print gain, and the aperture size.

The Reader tab simply gives you detailed information about the verifier such as its
serial number and build version, and when it was last calibrated.

The Scan tab provides details of when the image to be verified was scanned by the
verifier.

The bottom right section includes two tabs; ISO and Details.

The ISO tab will include details of all the parameters defined by ISO/IEC for the
particular barcode being verified.

The Details tab provides a breakdown of the results by individual scan line and by
parameter for the barcode highlighted.

The bottom left panel will include details that relate to the analysis of a symbol by
one or more of the optional plugins. Plugins are chosen by the user and they will be
used to check if the symbol meets the requirements of one or more applications.
More information about this is provided later on in this user guide.

The status bar is at the very bottom of the window, and provides details of what
the verifier is doing. If a verifier is not connected, the message ‘Found Readers 0’
will appear in the status bar. When a verifier is connected, the message will be
‘Selected reader: xxxxx’, where ‘xxxxx’ is the serial number of the verifier.
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Operating the verifier

Make sure the Axicon Camera Verifier program is open, the verifier is connected,
and press one of the buttons on the verifier or press the orange ‘Start scanning’
arrow on the toolbar. Then place the verifier over the barcode(s).

The message ‘Scanning’ will appear in the status bar at the bottom of the window.
With the verifier held still, press one of the verifier buttons again to begin the
decode process. You can also press the ‘decode’ icon in the tool bar. Do not move
the verifier until ‘Cancel decode’ appears or all codes have been found.

H = > EJOH

an... Print Report: “Standard PDF" | Start Scanning Cancel Decode | Settings... Calibrats
REF 80000527 REF 80000527
i 2017-01 2017-01

12051234 [LoT| 12051234
GTN 7332651925352 GTIN 7332551925352

1
| General Reader Scan

REF 80000527 |
[LoT] 12051234

| 7352551 925352 @ 201701
REF 80000527 :
[LoT] 12051234

S Tz2occ4l058252 A Wl

The verifier will draw a purple box around each of the barcodes it has found. You
must click on one of these to select it, and then the results will be displayed. Click
on any other barcode to see its results. Clicking on the selected code will zoom in.

When only one symbol is present the code will be selected automatically. To verify
the next barcode, simply press one of the verifier buttons or the orange arrow

to begin the scanning again. This action will clear all the details of the previous
verification.

Any linear barcode will be verified using ten different scan lines, as specified by
ISO/IEC 15416, and the verification grade will be based on the average of these ten
readings.
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Operating the verifier

The bottom right hand section of the window, with the ISO and Details tabs, will
provide you with more information, especially about linear symbols.

If the ISO tab is selected, and you click on the names for each parameter in turn,
you will see the scan lines across the barcode shown in the verifier window. These
will change colour according to whether that parameter has a pass (in green) or a
fail (in red) for that particular scan line. To get a scan reflectance profile of your
linear barcode you can press F9, select from the ‘view’ menu or click on the Details
tab and select individual scans, and then a particular scan info (1 to 10). The scan
reflectance profile (SRP) will now show at the bottom of the scan info results. Click

Svomingscn[| =)o 10 s G001 414112345 7830305 Scpiey

TR

U\]

on the reflectance profile to enlarge it. If you select an area of the SRP using your
mouse it will be enlarged. Click away from the .
enlargement to return to the complete SRP. @r’m'l'I.@.w‘@J- ole
When there are several symbols, click on each in e s e eie 1‘{:
turn to see its results. The now solid border will
change to different status colours to indicate
whether the symbol has passed or failed. Now
click on the selected symbol to enlarge it. To
see how each module has been assessed, click
on the name of one of the parameters. The

size of the circle shows the aperture size, and
a change in colour will highlight any relevant

modules for that particular parameter. Blue is ololo
the neutral colour for all these displays. Sle] lﬁl'l'lﬂ‘ﬂl'iliif

elele
u-oﬁii‘l;-;

M)

elelelele

OO
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Cropping

If the verifier has to look at a complicated image, with a number of barcodes,

and other images with rectangular edges, the software will take some time to
make sure that any rectangular edges are not plausible 2D barcode images before
decoding all the barcodes correctly. Cropping the image so that it only contains
the barcode you are interested in will speed up this process. This cropping will also
reduce the size of the scan file.

@8 Axicon Camera Verifier - [m] >
File View Reader Help

SON

e | Settings.. Calibrate... | UserData

Reposition the verifier during the scanning process so that the barcode is
approximately in the centre of the field of view. Then left click outside and above
the barcode, and a rectangular crop box will be drawn in the centre. You may need
to click again to make sure the box is large enough, and you may need to re-centre
the barcode. Now click on the ‘Search for barcodes’ icon or press one of the verifier
buttons. The crop box will become the whole image, the image in the box will be
decoded, and the verification results will appear on the right. The rest of the field
of view will have been ignored.
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Cropping

Click on the selected image to 8 txcon Cames Vi
enlarge it, and click again to take |—.|.

0
it back to its original size. 19 H =

Quit can... Print Report: "Standard PDF"

1

g Decode

Stop scannin

Clicking on the orange arrow icon
to restart the scanning process
(for another barcode) will reveal
that the cropping box is still
present inside the original field
of view. Right clicking within the
image panel will remove the box,
and left clicking will create a
new crop box.

Gen

@ Axicon Camers Verifier - o x

> RDOM

Start Scanning  Decode | Seffings.. Calibrate., | User Dota.

File View Reader Help

H =

Load scan... Save scan... Print Report: "Standard PDF"

P

Quit

Application Validation: N/A

General Reader Scan

6680333

Code 128
Pass grade 15
X Dimension 2522 um
P Gin Cmemimemon
Height 7.3mm
‘Width 27.9mm
Aperture 125 um
Left Quiet Zone 10 items: 10 Pass.
Right Quiet Zone 10 items: 10 Fail

1s0 Details

overa
Maximum Reflectance 88.9%*
Threshold 445%*
Reflectance Margin TO0%*
Defects 02 41.2%*
Decodaity wmo
Decoce
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Saving and using scan files

The image, and verification and plugin results of any codes that have been verified
can be saved in a scan file. This is done by choosing ‘Save scan...’” from the File
menu.

The scan file is the basis for the verification reports that are created from it. For
example, one scan file may include four barcodes if each one has been decoded and
each barcode will have its own verification results.

To open a saved scan, select Load Scan from the File menu.

When a saved scan file is opened by the application, the original data is available
and displayed. In addition, the original image can also be re-verified using the
‘search for barcodes and decode them’ icon - this will then automatically use any
plugins that are activated regardless of whether the plugins were used at the time
of original verification. The plugin details will be included in each verification
report.

The full verification results are then shown and reports can be viewed (and printed)
as required.
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Saving and printing reports

& erifier - o %
H s culss. o L]
Save Report &) Data Matrix CSV.
Append Report > Detailed plugins (PDF) . e e
V| Open Report Detailed plugins HTML
= Print Report culp 4.0/08/660 (A)
i Snaey | REF 80000527 S—
Standard HTML
Standard PDF 1 (i) 2017-01 0107332551925352171701001012051234
it Template: available-tags.txt 5
LOT| 12051234 LOT| 12051234 188
GTIN 7332551925352 GTIN 7332551925352 fivs
T
REF 80000527 St
LOT| 12051234
7 - -l ® w01
3325517925352 .
1 L T REF 80000527
LOT 1 2051 zu 150 Details T
4A)
Ly =l @ 2ot inem
7332551929352 HE
4A
4
4A)

(01)07332551925352(17)170100(10)12051234.

Status | Element Value o Notes| Errors | Warnings |
[P 01 0733255192535 e Item Number (GTIN) [n2+n14]

—
[Bassll 10 12051234 Batch or Lot Number [n2+n. 20]

Warnings: Notes:
‘m (17) must be processed together with Al: GTIN or ITIP or (255)

A verification report may be saved in .csy, .pdf, .html or .txt formats. Additionally
reports can be manually saved for subsequent printing or printed without saving.

Select ‘Save Report’ from the File menu and select the required format from the
list. This selection will be remembered and can be repeated with the shortcut
Ctrl + R.

If you want the report to be automatically opened on creation (for example, if
there is a need to print the report) then tick the ‘Open Report’ box.

You can append verification reports if you are using a CSV format, and you have
ticked the ‘Append Report’ box. If this box is left unticked and the file name is not
changed, the data will be overwritten.
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Settings

The verifier has a range of configuration settings. These can be set by clicking on
View and then selecting Settings.

Appearance: The Appearance tab allows you to set the appropriate colours for
“Fail”, “Warning” and “Pass”, choose the language, set the units of measurement
to metric or imperial units and set the pass grade. Plugins (chosen on the next
tab) will often have pass grades, but if you want to set a higher value for the pass
grade, make the change here. Hover text will appear to help you understand these
settings. The appearance tab also offers the option to resize the appearance of the
toolbar and to show text.

Plugins:

#5 Settings - O X

Appearance Plugins Reports Saving Lookup User Data Calibration Advanced

Available Plugins: Plugin Description:

A | |This plugin will recommend that an aperture of 80% of the module size of a two dimensional
Brazil Healthcare Default (Off) code should be used for verification.
cIp Default (Off)

Code 39 Check Character Default (On)

DAVA Healthcare Default (Off)

GS1 Data Content Default (Off)

GS1 Distribution Default (On)

GS1 Documents, Assets & Locations Default (On)

GS1 Global Service Relation Numbers Default (On)

GS1 Healthcare (bedside) Default (Off)

GS1 Healthcare Retail Default (On)

GS1 Pharmacy & Distribution Default (On)

GS1 Retail (point-of-sale) Default (On)

GS1 Retail (point-of-sale) & Distribution Default (Off)

Default aperture (2D)
GS1 UPC Human Readable Default (On)
®)I50/IEC 15415

HIBC Default (O
efault (On) v O Percentage of module size: : %

Fixed value: 20005 um
Disable all Default all o = M

"Ask User' plugins When no plugins recommend an aperture (2D)
(O Wamn and use default

(®) Use default silently

(O Show prompt

[] Allow multiple ‘Ask User' plugins for each scan

1 Allow to not apply any ‘Ask User' plugin

X Cancel
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Settings

Plugins: The Plugins tab is used to select how the symbols will be checked for
their data content, their dimensions, and any other aspects defined by a particular
application. These include GS1 Data Content, which will check for correct
combinations of application identifiers, GS1 Retail (point-of-sale) which will check
the type and size of the barcode, and many more. By default, many plugins are
switched off. To change this, select the plugin you require, and choose from the
drop-down list: On will check relevant codes, Always Show will check every code,
Off will deactivate the plugin, and Ask User will ask for confirmation everytime.

o Off: Never show results from this plugin.

o Default: Use the plugin’s own choice of whether to display results.

o “(Off)” means this plugin has requested to be disabled unless explicitly set to
“On”.

e “(On)” means this plugin has requested to show results for all applicable codes.

e On: Show results from this plugin for all applicable codes.

o Always Show: If this plugin can display results, show them for all codes,
whether applicable to the plugin or not.

e Ask User: Display this plugin in a list from which the user can choose, whenever
a code is scanned.

There is also an option at the bottom of the list to disable all or to revert to the
default settings.

The plugins tab also offers the choice to change the default aperture for 2D
barcodes and to prompt when no plugins recommend an aperture.
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Reports

#5 Settings - O X
Appearance Plugins Reports Saving Lookup User Data Calibration Advanced

Data Matrix CSV Data Matrix CSV

Detailed plugins (PDF)
Detailed plugins HTML
GS1 format HTML
Linear CSV

[Jsave []print

File Name

Use Decode

QR Code CSV
Standard CSY Use Date & Time
Standard HTML .
Standard PDF Directory:
Standard plain text ‘
Template: available-tags.txt
Append
[Ienable
File:
| [
D Save As
[JAllow Cancel

Show In Menu

Report Source: C:\Program Files\Axicon\Camera Verifier\scripts\reports\data-matrix.csv

In this window you can enable automatic saving and/or printing of reports. Select
the type of report file and choose an output file where the data will be kept. There
is an option to add the records to an existing file rather than replacing the file,
which is of benefit with text files, including CSV files. Choose Append and then
where you want these reports kept.

If Use Decode box is ticked, the report name will automatically be created using
the first digits of the decoded number.

If Use Date and Time box is ticked, the report name will automatically be created
using the date followed by the time as a file name.

If Use Decode and Use Date and Time boxes are both ticked, the file name will
automatically be created using the decoded number followed by the date and time.
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Settings

Saving: The Saving tab can be used to enable automatic saving of all of the scan
files for audit purposes. The enable box must be ticked for the software to save the
scan files. Browse to your chosen location in the directory.

If Use Decode or Use Date & Time (or both) are ticked, then the dialogue box

will appear with the pre-selected data and allow the operator to override this if
required.

Lookup

% Settings

Appearance Plugins Reports Saving Lookup User Data Calibration Advanced

Database Lookup
Import CSV [JEnable
File: Lookup field:
‘ | GTIN -
Auto import at startup Result fields:
GTIN

First line contains column headings

Separator:l:l Quote:El

Import

Product

Number of rows: 8

View data

Parsing
Extract GTIN-14

[ Trim leading zeros

X Cancel

This window enables users to check the GTIN or other data in the barcode being
verified against a database of records. For example, you can check that the GTIN
has been assigned to a current product, and have its description displayed. The
database will need to be exported and saved in a .csv format.
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First of all click on the Import button (which is on the left hand side of the window)
and then select the .csv file that you have established as the database. You can
check if this is the correct one by clicking on the View data button towards the
bottom left of the window.

Then choose the Lookup field from the dropdown menu on the right hand side of
the window to select the heading for the column of the table that records all the
GTINs.

Then go to the Results field box below to select which data you want to be shown
on the report. Ticking both the heading for the column that records all the GTINs,
as well as the appropriate product description will mean that both entries are dis-
played together.

Now go to the top right of the window and tick the Enable box.

The parsing box on the bottom left of the window provides different options for
dealing with GTINs. Tick the Extract GTIN-14 option to keep the GTIN in a 14-digit
format, and tick the Trim leading zeros option to ignore any unnecessary leading
zeros.

The result of the lookup will be included in the barcode verification report.

EAN-13

Ll

= H \
51012345"78900">

Found: 5012345678900

= Maxi
Element Value > Thre:
= Min

Product Hand Sanitiser

¥ GS1 Retail ¥ Lookup

“““‘g g I‘

Found codes: 1
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Settings

User Data: User Data allows you to program the Axicon 15000 series software
to ask questions when a verification is being made, to collect the answers and

to store these with the verification report. This
supplementary user data will then always be
displayed with the verification report.

Such data may typically be a job reference
number or batch number, but equally it could
be information about the barcode such as the
substrate or print process or details about the
operator, the department or the site. Multiple
questions can be entered if desired.

To set up the User Data:

From the View menu select Settings. Click on the
User Data tab of the Settings window. To add a User
Data item press the + symbol at the bottom left of
the window. The Create User Datum window will be
shown. This can now be completed as required.

An example of a Job Reference entry is shown here.
The title is entered and the Allow Blank is un-ticked
to force you to enter data into this field.

# Create User Datum — ] X

Item Title:

Allow Blank Content
Allow Edit
Default:

‘ v

[ Reset to default value each scan

Pass Value:

[ Check value

Preset Values:

¥ OK

#% Create User Datum — O X

Item Title:
‘Test

Allow Blank Content

Allow Edit

Default:

‘ Finished products v

[ Reset to default value each scan

Pass Value:

[ Check value

Preset Values:
Artwork

Proof

Label

Finished producd

" OK X Cancel
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This sample shows how
you can be offered a pull-
down menu of options
but with a default option
given. The default can be
left blank. When the list
of selected questions has
been completed press
the OK button.

Now when you verify

a barcode and select
‘save’ scan the User Data
dialogue window will
appear and allow you

to enter the required
information. If you now

www.axicon.com

fﬁ User Data

Test

‘ Finished product]

Artwork
Proof

Label

+ OK X Cancel

save the scan file the User Data information is automatically saved with it.

When loading a pre-saved scan file for which User Data has been attached you
simply need to load the scan file, and re-verify the code using the Search for all
barcodes icon and then select View/User- Data from the pull-down menu.

The Axicon software also includes a facility for transferring the User data settings
from an existing scan file (whether made from this computer or not). Simply load an
existing scan file, go to the View/settings/User Data screen and then press the ‘Add

the user data fields’ icon.

There are also facilities to edit an existing User Data entry (ideal for adding items
to a pull-down menu). You can also clear any existing User Data requirements and
prompt the user data to always show.
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Settings

Calibration

# Settings - O X
Appearance Plugins Reports Saving Lookup User Data Calibration Advanced

Calibration card reflectance
RMin: : RMax: :

Expiry

Days until calibration reminder: :

[~ Allow scanning when calibration expired

X Cancel

This window allows users to enter the minimum (RMin) and maximum (RMax)
reflectance values for calibration (see page 7).

This windows also allows the option to change days until calibration reminder and
to allow or not to allow scanning when calibration has expired.
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Advanced: This window allows you to lock all the settings for the verifier so that
other users cannot change them, and to require individual users to login before
using the software. A supervisor, who will take control of making any configuration
changes for all of the users, needs to follow the instructions below to ensure that
users have the same settings and are not able to make changes to those settings.

By default the settings for the Axicon Camera Verifier software are independently
configurable by each user of the software. This means that if several people use the
same PC and verifier, and login in with their own user names and passwords, they
can each change the settings to suit their use of the verifier.

The process of calibrating the verifier results in the

storage of data that is used by all users, so that a ] users Properties X
change of user will not require the verifier to be General | Securty  Detals | Frevious Versions
re-calibrated. By default all users are allowed to L e
calibrate the verifier.
Type of file:  Configuration settings {ini)
X . . Opens with: 7| Notepad Change
To use this window you will need to change the
. P o . Location: C:\ProgramData“Axicon\Camera Verifier
read-only attribute for the ‘users.ini’ file, which o 12%;5 st
is in the common configuration directory. This file Sz ondek: Dbytes
normally has a read-only attribute which disables
. ) . . Created 30 January 2018, 16:00:04
the common configuration and user login settings. Medfed 30 May 2018, 14545
This is done to prevent changing the settings by Acoessed: 1 une 2010, 063835
accident because it will affect all users on the prbtes G Clisdden [
computer.
Go to the hidden folder “C:\ProgramData\Axicon\
Camera Verifier”, right-click on ‘users.ini’, select = b
‘Properties’ and untick the ‘Read-only’ tick box and
click on ‘OK’.

Restart the camera verifier software and the common configuration and user login
options will now be enabled in the Advanced window of the Settings dialog.
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Settings

% Settings

Appearance Plugins Reports Saving Lookup User Data Calibration Advanced
Configuration Files

Use commaon configuration
Requires a software restart to take effect.
Ul settings: Ch\Users\x¥\AppDatat\Local\Axicon\Camera Verifier\acvgui.ini
Decode settings:  C\Users'xx\AppData'\Local\Axicon\Camera Verifier\decode.ini
Reader settings:  C:\ProgramData\Axicon\Camera Verifier\reader.ini

Reader log: Ch\ProgramData\Axicon\Camera Verifier\reader.log

User Login
Require user login

Requires a software
restart to take effect.

% Settings
Appearance Plugins Reports Saving Lookup User Data Calibration Advanced
Configuration Files
Use common configuration
Requires a software restart to take effect.

Ul settings: C\Users\cp\AppData\Local\Axicon\Camera Verifier\acvgui.ini

Decode settings: C:\Users\cp\AppData\Local\Axicon\Camera Verifier\decode.ini
Reader settings: C:\ProgramData\Axicon\Camera Verifier\reader.ini

Reader log: C\ProgramData\Axicon\Camera Verifier\reader.log

User Login
:Require user Ingin:

Requires a software restart to take effect.

Aodie oo

When a supervisor ticks the ‘Use
common configuration’ box, all
the settings that the supervisor
has made will be applied to
everyone that uses the computer.
The settings are now locked by
the supervisor that enabled the
option and only this user can
disable it.

Optionally the ‘Require user
login’ box can be ticked, then
every time a person opens

the software, the computer’s
Windows operating system login
screen will appear.

You must restart the software
now so that these changes take
effect. If you return to this
window, you will see that it now
looks like the image on the left.

After restarting the software, the
Advanced tab of the configuration
window shows the location of

the configuration files for the
software which apply to all users.
Decode settings will normally be
blank and are mainly for testing

purposes. User Interface (Ul) settings (the ‘acvgui.ini’ file) are for the configuration
options that are available through the settings dialogue and after enabling the ‘use
common configuration’ option these settings will be assigned read-only permission
for all users except for the supervisor who will have full control.
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If an organisation wants to grant X o bropetis X
permission for an additional b | iy m———
supervisor to be able to modify the
software configuration settings, T 2 S| HTOP RS RS Sma)
then the Windows security settings
for that additional supervisor need Tochers emose ik o et £ T
to be set to allow write and modify S e s
permissions for the acvgui.ini file on (o < R
the Security tab of the properties = v - v
dialogue which is accessed through .
Windows File Explorer. B | R

e o Cancel o
Reader settings (the ‘reader.ini’ file)
stores the calibration data for each U e ;
verifier that has been connected e Tt s, | | T st e ot
to the computer and calibrated. g e
By default, all users will be able to | e e T
calibrate the attached verifier as
all users will have write permissions """ ™% e memwemmEmo G
for this file. If an organisation wants bl it D o y mw T
to limit which users can perform e v P s v
calibration, then the permission to o Y v

write to the reader.ini file should be  fmiemassmetinn | e P puons o ol 1. | Aons
denied for individual users or groups

of users, as shown in this properties cod ] IR ==l
dialogue for ‘User1’. Any users (or groups of users) that are not denied permission
to write to this file will continue to be able to calibrate verifiers on the computer.

In the Advanced tab of the settings menu there is also an Audit Log option. This will
create a log of all settings changes, saving, printing and calibration operations. It
is recommended that either autosaving of scans or reports (or both) are enabled so
that every verification scan is recorded in the audit log. All entries in the log will
include the time and date as well a record of the user that is running the software.

A copy of the audit log can be exported (as a .csv file) by clicking on the ‘Export to
CSV’ button.
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Settings

The Advanced tab also includes two options on its right hand side. These enable a

change in the quiet zone required for QR Code, and for changing the verification
process for direct part marked (DPM) symbols.

%Seﬂings — O X
Appearance Plugins Reports Saving Lookup User Data Calibration Advanced

Configuration Files QR Code

[ use commen configuration Reduce the QR code quiet zone from 4 modules to 1 module which may
affect some grades, espedially fixed pattern damage. Does not conform to

Requires a software restart to take effect. 1SO/IEC 18004.

Ul settings: C:\Users\cp\AppData\Local\Axicon\Camera Verifier\acvgui.ini D One medule quiet zone
Decode settings: C\Users\cp\AppData\Local\Axicon\Camera Verifier\decode.ini

Reader settings:  C:\ProgramData\Axicon\Camera Verifier\reader.ini Direct Part Marking

Reader log: C:\ProgramData\Axicon\Camera Verifier\reader.log

Medified analysis, according to ISO/IEC 29158, for directly marked parts by
techniques such as laser etching which generally produces low contrast
User Login symbols. All symbologies other than Data Matrix will be disabled.

[[JRequire user login [JEenable

Requires a software restart to take effect.

Audit Log

QR Code

The ISO/IEC standard for QR Code (ISO/IEC 18004:2015 QR Code barcode symbology
specification) requires all QR Codes to have a quiet zone with a width of at least

4 modules on all sides of the symbol. If you choose to use this smaller quiet

zone requirement, and not be compliant with ISO/IEC 18004 or the GS1 General

Specifications, tick the option for ‘One module quiet zone’. This will be reported in
the results.

Direct Part Marking
If this option is enabled, the verifier will verify the 2D symbol following the
requirements of ISO/IEC 29158 Direct Part Mark (DPM) Quality Guideline, and not

ISO/IEC 15415. This option will also disable the verifier’s ability to verify any linear
barcodes.

Direct part marked symbols are not printed conventionally, but are created by
modifying the surface of the item, using techniques such as laser marking,
electro-chemical etching, dot peening, and engraving. These symbols may have

a lower symbol contrast than other symbols, which could impact the scanning
performance with a conventional reader. These DPM symbols may only be readable
under specialised lighting conditions.”
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When in DPM mode the
reflectance levels of the
captured image are optimised
before decoding and verifying
the symbol. Best results are -
obtained by cropping the image ;} =
so that the image only contains
the barcode that you want to
verify. This is explained on page
13 and 14.

The verifier software allows you
to see the difference that using
the DPM approach makes to the
barcode image. Go to ‘View’ in
the main menu, and then click =
on ‘Show DPM Image’, or use
the shortcut key F4 to toggle
between the optimised and
unmodified images.

The result of the verification
will be prefixed by the letters
‘DPM’, and the grade, aperture
reference and wavelength of
light will be followed by details
of the angle of illumination and
its direction. For example, a
symbol’s grade could be stated
as follows:

DPM 2.0/10/660/45Q

45 means a lighting angle of
45°, and Q means it has been illuminated from all four sides. The 15200 and 15500
models only use this lighting angle and direction of lighting.

This DPM option should only be enabled when it is appropriate to apply ISO/IEC
29158 and the symbols will be read using a specialised DPM scanner.
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Annual service

All verifiers need servicing every year to ensure that they measure barcode quality
in accordance with the relevant ISO/IEC standards. This verifier conformance and
alignment service (VCAS) ensures that the verifier is internally dust-free, checks
that it is focused correctly, and adjust the hardware to account for any change in
the brightness of the LEDs used to illuminate the barcodes.

This annual service is not the same as user calibration, as it looks at the output of
the LEDs and corrects for any variance in their evenness of illumination across the
whole field of view. Over time the LEDs will fade but they will not fade uniformly.
User calibration ensures that the verifier is measuring the darkest and brightest
reflectance’s correctly but it cannot correct for any variance in the illumination.

After your verifier has been serviced, we will return it you with the latest version
of the software on CD together with a new calibration card, and a new user guide
that will include the new certificate of ISO/IEC conformance. You will then need
to calibrate the verifier before you use it again. The latest software can always be
downloaded free of charge from our website, www.axicon.com.

e-Cert —
Returning a verifier to us for this annual VCAS

(verifier conformance and alignment service) is
sometimes difficult, yet the verifier may still be

operating within its expected tolerances, and e €D \\““
could be re-certified as being conformant to /
the ISO/IEC standards for barcodes and barcode - ‘
verifiers. Using eCert provides you with the |
reassurance that the barcode verifier is working . D

correctly without having to return it to us. //
[ St CARD =y

We supply a set of specially produced barcode
test cards, a new calibration card, and
instructions about how to use them and upload
the results to an Axicon web platform. Axicon’s
technical staff will assess the results, and if the
verifier passes we will supply you with a new
certificate of conformance that lasts for one
year.
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Warranty

The Axicon 15000 series verifier is sold with a two year parts and labour warranty
against manufacturing defects. This is a return to bench warranty with shipping
costs in one direction being borne by the customer/distributor.

Should you need to return the unit to Axicon the original case (plus appropriate
packaging) must be used. If the equipment is returned without the original case, we
will automatically charge an additional sum for its replacement.

Axicon’s standard repair turnaround time is 7-10 working days. This standard
warranty does not include the provision of a loan unit. Loan units can be supplied
on request.

Axicon reserves the right to charge an inspection fee for any equipment returned
under warranty for which no fault is found. Please contact us to obtain an RMA
number before returning any equipment. This number must be quoted on all
documentation. We cannot accept responsibility for equipment returned without an
RMA number.

Disclaimer

In the following the expression Verifier means the verifier hardware and the
associated software.

We have taken care to ensure that this Verifier is free from defects. However since
we have no control over the circumstances in which you might use the Verifier,

you must satisfy yourself that the performance of the Verifier is suitable for your
needs. Neither Axicon Auto ID Limited nor the vendor of this Verifier can accept any
liability for any loss or damage (consequential or otherwise) which may be caused
by use of this Verifier.

If the Verifier or any part of it is defective in any way, or in some other way does
not meet your expectations, the liability of Axicon Auto ID Limited is limited to the
cost of the product. You should bear this limitation in mind if you use this Verifier
in any situations where the acceptance or rejection of shipments of goods or your
reputation may depend upon the quality of a barcode.
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Contact us

Axicon Auto ID Ltd
Church Road

Weston on the Green
Oxfordshire

0OX25 3QP

UK

Tel: +44 (0) 1869 351 155
Fax: +44 (0) 1869 351 205
Email: info@axicon.com
Website: www.axicon.com

As Axicon continually improves its products, their specifications and features are
subject to change without notice. All trademarks are acknowledged as belonging to
their respective companies.

EU authorised representative:
Axicon BV, Spoorstraat 55M, 5831CJ Boxmeer, The Netherlands

Your Axicon distributor




